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Technical requirements 

The application eForm is an interactive PDF form that requires Adobe Reader software to be 
installed on your computer for you to be able to complete and submit it.  

The creation, download and submission of the form are ‘online’ activities but completion of the form 
and its validation are ‘offline’ activities.  

Adobe Reader 

The minimum version i.e. lowest version of Adobe Reader that you must have installed on your 
computer is version 9. You may also use a higher version than this e.g. 9.1, X, XI etc. If you have a 
lower version than 9, you will not be able to complete and submit the eForm. 

Follow the link below to be directed to Adobe's website to download the software free of charge or 
to upgrade your existing copy of the software. If you do not have administrator rights on your 
computer this activity may require the intervention of your IT department. You will need to specify 
your operating system before the download can commence. 

http://get.adobe.com/reader/otherversions/ 

If you are using Adobe Acrobat (Standard) or Adobe Acrobat Professional, the version must likewise 
be 9 or higher. 

The screenshots in this User Guide are based on version 9 of Adobe Reader. 

You can check the system requirements for Adobe Reader – i.e. the minimum required specification 
of your computer – through the following link: 

http://www.adobe.com/uk/products/reader/systemreqs/ 

Risk of corruption from other PDF readers 

Some non-Adobe PDF readers have been known to corrupt eForm files, rendering them unusable 
and/or unsubmittable. Only therefore use Adobe Reader or one of the Adobe Acrobat products. 

Internet Connection & Browser software 

You will require an internet connection and standard browser software to retrieve and submit the 
online application form. 

Security settings in some versions of Adobe Reader and Adobe Acrobat 

If you are using a version of Adobe Reader or Adobe Acrobat that incorporates Enhanced Security, it 
is very likely that the enhanced security settings will block the submission of your eForm. The 
involved versions of Adobe Reader and Adobe Acrobat are: 

 9.3 or any higher version 9 than this (including any sub-versions e.g. 9.3.1, 9.4.2 etc); 

 any version X (including any sub-versions e.g. 10.0.1); 

 any version or sub-version higher than version X e.g. version XI. 

The disabling of the Enhanced Security is performed from the following Adobe Reader menu path: 

 Edit > Preferences > Security (Enhanced) 

http://get.adobe.com/reader/otherversions/
http://www.adobe.com/uk/products/reader/systemreqs/
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Uncheck the box Enable Enhanced Security and click OK. Once the submission has been performed 
you can re-enable the Enhanced Security. For more detailed instructions (including screenshots),  
please refer to the relevant 'Known Issue' on the EACEA eForm homepage: 

http://eacea.ec.europa.eu/eforms/index_en.php#issues 

Here you will also find instructions on how to leave Enhanced Security enabled but identify your 
eForm as a trusted item so that its submission is not blocked. 

Account with the European Commission - ECAS 

Access to the systems involved in creating an application eForm is validated by ECAS, the European 
Commission's Authentication Service. Applicants must therefore have an ECAS account. If you do not 
yet have an ECAS account, please visit the ECAS registration website where you can create your 
account including an ECAS login username and password. The website is reached through the 
following link: 

https://webgate.ec.europa.eu/cas/eim/external/register.cgi 

Test your connection 

The Test your connection button appears in the footer of every page of the eForm. Click on this 
button to verify whether your computer settings and internet connection and settings permit a 
successful connection to EACEA's submission server to be made. This is not to perform the 
submission itself but merely to test your submission capability. When successful, you will see the 
message 'The connection test succeeded' appear in the footer of your form. If it fails, you will see the 
message 'The connection test failed' appear in the footer. In the latter scenario, you should consult 
the 'Known issues' section of the eForm homepage where you will find advice on settings etc.  

When you perform the connection test, you may see a security warning message pop up: 

 

Please note! A successful connection test only remains valid if the environment and settings in which 
it was performed remain the same! If you move your form to a different computer, switch to a 
different browser or internet service provider, or change your internet, browser or PDF software 
settings you must perform the connection test again. 

Advice for Macintosh Users 

The eForm can only be opened and completed using Adobe Reader or one of the Adobe Acrobat 
products. It is not possible to open and work with the eForm using the Mac Preview viewer. 

Please therefore ensure that if your default viewer is set as Mac Preview, you nonetheless open the 
eForm with one of the Adobe products mentioned above. This advice applies to both the download 
of the form – if you try to open it before downloading – and to the opening of the form for its 
general completion and submission. For more detailed advice, please visit the ‘Known Issues’ section 
of the EACEA eForm homepage: 

 http://eacea.ec.europa.eu/eforms/index_en.php#issues 

If you encounter the warning 
message, click on Allow to carry 
out the test. 

In some cases, a second security 
warning may pop up. If so, click on 
Allow to proceed with the test. 

http://eacea.ec.europa.eu/eforms/index_en.php#issues
https://webgate.ec.europa.eu/cas/eim/external/register.cgi
http://eacea.ec.europa.eu/eforms/index_en.php#issues
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Overview of the process 

The application process requires electronic submission of proposals, via the internet.  

The steps in the application process can be seen in the schematic diagrams below. 

The first schematic diagram – diagram A – shows the steps that are involved when creating a brand 
new application eForm. 

The second schematic diagram – diagram B – shows the steps that are involved when there is a 
requirement to revise the list of participating organisations. (An 'existing' application eForm is one 
that you previously created, saved and potentially started completing but have not yet submitted.) 

A. Creation of a new application eForm 

 
B. Revise list of participating organisations and update existing application eForm 
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STEP 1: REGISTER ORGANISATIONS 

The first step in submitting a proposal is performed in the EAC/EACEA Participant Portal. 

Before an applicant can create an application eForm, they must ensure that all the organisations that 
will participate in the application have been registered in the EAC/EACEA Participant Portal. Each 
organisation that is registered in the Participant Portal is allocated a unique Participant 
Identification Code (PIC). The PIC is a 9 digit number that helps the European Commission and 
Agencies identify a participant. It is used in all grant-related interactions between the participants 
and the Commission.  

If an organisation does not have a PIC number it cannot participate in an application.  

You will need an ECAS account in order to register your oganisation in the Participant Portal. If you 
do not have an ECAS account, you can find a link to the ECAS registration website in the 'Technical 
requirements' section of this user guide. The home page of the Participant Portal also includes a link 
to the ECAS registration website (click on the link 'Are you a new user?').  

To enter the Participant Portal, click on the following link: 

Enter the Participant Portal 

If your organisation has already participated in a 7th Framework Programme (Research) proposal, it is 
likely that the organisation has already received a PIC number.  You can search for existing PIC 
numbers in the Participant Portal via the 'My Organisation' option. 

The registration of your organisation in the Participant Portal will not take more than 10 minutes. 
Documents related to the organisation can also be uploaded in the portal. Please read carefully the 
call documents and information in order to know which supporting documents have to be uploaded 
in the portal. 

Please note: not only can a person register their own organisation, they may also register another 
organisation "on behalf of" that organisation. This can be helpful in case of large partnerships. 
However, because of the potential for conflicts and confusion, the "on behalf of" registration should 
be used only when strictly necessary. 

Once you have carried out Step 1, navigate to EACEA's Application eForm Homepage. 

Application eForm homepage 

The following link takes you to the Application eForm homepage on the EACEA website: 

Application eForm homepage 

Pay careful attention to the important points that are listed on the homepage. 

Once you have considered and, where necessary, addressed these points, you can proceed to the 
creation of your application eForm by clicking on the Create new application eForm button: 

     

  

http://ec.europa.eu/education/participants/portal/desktop/en/home.html
https://eacea.ec.europa.eu/PPMT/
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STEP 2: SELECT THE PROGRAMME, FUNDING OPPORTUNITY AND 
FORM LANGUAGE 

The next step is to select the programme, funding opportunity and form language version. 

A series of three numbered instructions will appear on screen. 

Instruction 1 

Select the programme you are interested in and click Search:  

  

A table of funding opportunities for your selected programme is displayed:  

 

 

If you make a mistake, simply select a different programme and click again on Search. 

You may filter the table of results using the filter-as-you-type facility. It checks all columns of the 
table for the presence of your filter text e.g.:  

 
 

 

Navigate multiple pages of results 

Filter 
results 

Set the number of 
results per page 
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Instruction 2 

Select your funding opportunity (action/strand) by clicking anywhere in its row: 

 

Your selected funding opportunity will now appear at the top of the screen and will also be 
highlighted in the results table:  

 

 

A selection menu for the form language version has also been added to the page. 

If you select the wrong funding opportunity, simply select a different funding opportunity from the 
table and it will appear at the top of the page, replacing your previous selection. 

If you wish to change to a different programme, use the previous step button to return to the 
previous screen. 

Instruction 3 

Use the dropdown menu to select the language version of the application form you require: 

 

Please be aware that for some funding opportunities the eForm may only be available in a limited 
number of languages. 
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Once you have chosen your language version, a Next step button automatically appears: 

 

The Next step button will not appear until you have selected your funding opportunity AND selected 
the language version! 

Click on the Next step button to move to the next page and proceed with step three, selecting the 
list of participating organisations.  
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STEP 3: SELECT THE PARTICIPATING ORGANISATIONS 

In Step 1, you obtained the PIC numbers of the organisations participating in your application. You 
must now use those PIC numbers to build the list of participating organisations. The Applicant 
Organisation is also selected during this step. 

Adding organisations 

For each organisation participating in your application, enter in turn their PIC number and click on 
the Add to list button:  

 

As you add your organisations, they are listed in an on-screen table: 

 

Select the Applicant Organisation 

Directions for applications with ONLY ONE PARTICIPATING ORGANISATION 

If there is only one organisation participating in your application, click on the Next step button to 
proceed to the next page where you can confirm your various selections. In this scenario, the 
organisation you added will automatically be defined as the Applicant Organisation. 

Directions for applications with TWO OR MORE PARTICIPATING ORGANISATIONS 

When you add a second organisation, a new selection menu automatically appears above the 
partner list table. This is the menu for choosing the Applicant Organisation: 

 

This new menu should be used to specify which organisation in the list will perform the role of 
Applicant Organisation. If the Applicant Organisation already appears in your list you may select it 
now using the menu. Or you may continue adding all your organisations and then use the menu to 
select the Applicant Organisation from the full list.  

Enter a PIC number 
and click Add to list 



Proposal submission  User Guide 

Version 1  Page 12 of 39 

The organisation that you select to be the Applicant Organisation is highlighted in pink: 

 

Whichever organisation you select as the Applicant Organisation, it will appear first in the eForm 
that you will eventually create. The Applicant Organisation is always the first one in the eForm. 

Important! 
Once you have created your application form, it is not possible to switch the role of 

Applicant Organisation to a different organisation. 

If, after creating your form, the responsibility for performing the role of Applicant Organisation 
passes to another organisation you will have to abandon the application form you had created and 
create a brand new application form.  

Coordinator selection 

Selection of the Coordinating organisation, where relevant, is wholly managed within the application 
form itself. There is no requirement during the creation of the list of participating organisations to 
specify which organisation will perform the role of Coordinator / Coordinating organisation. 

Removing organisations 

To remove an organisation from the list, check the corresponding checkbox at the end of the 
organisation row concerned… 

               

…and then click on the Remove checked organisation(s) button. 

Check multiple rows for multiple organisation deletion.  

To remove all rows in one go, check the checkbox on top of the column… 

             

…and then click on the Remove checked organisation(s) button. 



Proposal submission  User Guide 

Version 1  Page 13 of 39 

Organisation list complete 

When you selected the Applicant Organisation, the Next step button was added to the bottom of the 
page. When you have finished building your organisation list, click on the Next Step button to 
proceed to the next page where you will have the opportunity to confirm your selections and create 
your application form: 
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STEP 4: CREATE AND SAVE THE APPLICATION EFORM 

This page summarises the selections that you made in the previous steps: 

 

If all the details are complete and correct, click on the Create application eForm button. If any details 
are incorrect or missing click on the Previous step button to make the necessary changes. 

When you click on the Create application eForm button, a popup message appears: 

      

Carefully read the message content and then click OK to continue or click Cancel to return to the 
details confirmation page. 

Save the application eForm 

When faced with the option to open or save the form, SAVE it to your local computer or network 
drive. It is recommended that you use the Save As option, so that you can precisely select the 
location where the file is saved.  

It is not possible to open and fill in the application form within the browser. You must first save the 
form to your local computer or network drive. Once it has been saved, you can begin filling it in 
(using Adobe Reader or one of the Adobe Acrobat products). 

If you do not save your application form, you risk losing all the information you entered so far (PICs 
etc.) and having to start again.  
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List of partner organisations is not valid 

If, when you open your eform, the list of partner organisations is displayed and is accompanied by 
the message that your list of partner organisations is not valid, you will not be able to use the eForm 
you just created. You will have to abandon the eForm as the partner list error(s) mean that it is not 
possible to validate or submit the form.  

The following screenshot provides an example of the error message: 

 

Please note: this is only an example of the error. Other types of invalid list error may be 
encountered.  

If you encounter an error in your list of partner organisations when opening your eForm, please take 
the following action: 

 take a print or make a note of any rules that have not been respected; 

 check the eligibility rules that apply for the funding opportunity you are applying under; 

 start again the process of creating a new application eForm, making sure that this time you 
respect all applicable eligibility rules. 

 

 

 

  



Proposal submission  User Guide 

Version 1  Page 16 of 39 

Your saved form - protected fields 

The funding opportunity details that you selected will appear in the form as protected i.e. 
unmodifiable fields. This is indicated by grey diagonal lines that provide the background to the fields: 

 

Likewise, the organisation information you incorporated will appear as protected fields. For 
example: 

 

If the organisation information that appears in the protected fields is incorrect or is out-of-date, the 
data cannot be modified directly in the eForm but must be modified in the Participant Portal. After 
the modifications have been carried out in the Participant Portal, they must also be integrated into 
your eForm (if it has not already been submitted). In order to integrate the modifications into your 
eForm, please follow the steps described in part B of this guide, 'Revise list of participating 
organisations and update existing application eForm'.   
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STEP 5: COMPLETE THE APPLICATION EFORM 

Generic guidance  

This section provides generic guidance on how to work with and complete an application eForm. 

Navigation panel 

 

 

 
Toolbar 

From the Tools menu you can customise your toolbar e.g. you can add the Save button if it is not 
already displayed. There are also various display and navigation options that you can add. 

 

 

Toolbar 

Customise 
toolbar 

selection 
menu 

Attach facility 

DO NOT USE! 

The eForm has its 
own attach facility 

Activate 
Page Thumbnails 

(see below) Activate the 
Highlight Fields 

facility 

VERY USEFUL! 
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Here are some of the commonly used display and navigation options: 

 

 

 

 

 

Page Thumbnails 

If you activate the Page Thumbnails option, a new panel is opened up on the left-hand side of the 
screen. It contains miniature previews (‘thumbnails’) of each page: 

    

Zoom in / Zoom out 

To rapidly zoom in or out, press CTRL on your keyboard and move the scroll wheel on your mouse: 

  Scroll up  to zoom out, increasing the size of the image 
  Scroll down   to zoom in, decreasing the size of the image 

  

Zoom In 
(reduce 

image size)  

Zoom Out 
(enlarge 

image size)  

Fit form to 
width of window 
and scroll across 
page boundaries 

Show one 
 whole page 

 at a time  

Move to 
previous 

page  

Move to 
 next page  

 Use the 
thumbnails to 
jump to different 
pages of the form.  

 

 A frame outlined 
in red indicates 
where you are in 
the document. 

 

 Right click on the 
panel to access 
options to enlarge 
or reduce the 
thumbnails.  

Red frame 
indicating 

your 
location   
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Entering content 

The eForm is an interactive PDF form that contains form fields that are either selected from a 
restricted list or filled in using free text: 

 click inside a text field to enter data; 

 click to select options from e.g. dropdown lists, checkboxes, pop-up calendars and 
radio buttons; 

 press Tab to move forward one field or Shift+Tab to move backward one field; 

 point and click with the mouse to select a specific field. 

Mandatory, optional and protected fields 

Field Type Characteristics Examples 

Mandatory 
Field label is accompanied by an 

asterisk *  

        

Optional Field label has no asterisk 

             

Protected 

(unmodifiable) 

Field contains diagonal grey lines. 

These fields are either incorporated 
into the eForm when it is created or 
they are calculated / filled 
automatically by the form itself. 

   

 

Tooltip for long descriptions 

Where a description overflows the menu box, hover your cursor over the menu item to display the 
full description in a tooltip: 
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How to highlight mandatory fields 

Click on the purple button  in the navigation panel and this will activate the Document 
message bar which incorporates the Highlight Fields feature. 

 

Mandatory fields – red border and a light blue background 

Optional fields – light blue background (and a black border when you hover the cursor over them). 

        

 

 

 

Please note: if any mandatory field remains incomplete the eForm will not validate successfully and 
it will not be possible to submit your form. Where a numerical field is mandatory but you have no 
value to enter, please make sure you enter a zero to indicate your null value. 

Once you have activated the highlighting you can click the purple button  again to remove the 
Document message bar (and maximise the display of your form). 

Saving your form 

To save your form, click on the Save button on the toolbar or select Save from the File menu or press 
CTRL and S. 

 

Please ensure that you save your form on a regular basis. If you encounter a problem in your local 
computing environment and your form or your computer crashes, the Adobe Reader auto-recovery 
function will only restore your form to the point of the most recent save. 

  

Unhighlighted 
fields 

Highlighted 
fields 

Click on the Highlight Fields button and all 
mandatory and optional fields will gain 
highlighting that makes them easier to identify 
(and easier to differentiate from one another). 
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Using the Add and Delete buttons (eForm tables) 

Some fields or groups / blocks of fields are required to be completed more than once allowing you to 
build up a 'table' of information e.g. a list of political objectives or priorities. Whenever you need to 
insert a new 'blank' field or add rows to a table, you will do this by using the Add buttons. 

These buttons are coloured green. Click on them to add the desired new field or table row. 

 

 

 

 

Once you have added a field or row, the delete facility – an orange-coloured button containing an 'x' 
– appears so that you can delete the field, block of fields or table row concerned (and its contents!). 

Please note: some tables are optional but contain fields that are mandatory once a row has been 
added. 

Formatting 

If you enter formatted content into the form e.g. through copy-and-paste from other document 
sources, the eForm will strip off the formatting and plain text only will be pasted into the form. 

Please do not copy bullet points into your form. The formatting of some bullet points can trigger 
the requirement to download add-ons to your Adobe Reader software (so that it can handle those 
bullet points). 

Character limits 

The free text fields in the eForm have character limits that restrict the amount of text you can enter. 
These limits include both characters AND spaces. If you try to enter more characters than the limit 
allows the form will simply restrict the text to the predefined limit. Many word processing packages 
have a 'count' tool that may help you respect the limits. See also Annex 1 of this user guide for 
details of the character limits for fields where the limits are not cited directly on the eForm. 

SPECIFIC eForm advice and instructions linked to your selected funding opportunity 

The advice throughout this user guide is generic in nature i.e. it applies to all application eForms 
regardless of the programme concerned and regardless of the funding opportunity concerned.  

However, as eForms have different designs and can contain different functionality, some eForms 
require additional SPECIFIC guidance and instructions that are only relevant to their design and 
content. If your eForm requires any such specific instructions, these will be included in Annex 1 of 
this user guide. Please therefore ensure that you consult Annex 1 and take into account any 
guidance or instructions that you find there. 

Click here to 
add a new 

row Click here to 
delete a row 
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Attachments 

Most application eForms include buttons for the attachment of mandatory annexes. These 
document annexes are a formal part of the grant application and must be attached to your eForm.  

The attachment section is located towards the end of the eForm and the following screenshot 
provides an example of how it may look: 

 

As the screenshot above is merely an example, your own eForm may include different document 
attachments from the ones displayed above.  

To carry out the attach operation, click on the relevant Attach a document button and a window will 
pop up enabling you to browse, locate and select the file you wish to attach: 

  
 
 
 

Once a file has been successfully attached, the filename is displayed and the Attach a document  
button is replaced by a Delete this document button and a View this document button: 

          

Attachment size limitation 

There is a limit to the total (combined) size of your attachments. This is 5MB. If you receive a 
message advising you that the total size of documents exceeds the maximum allowed, please reduce 
the size of the image-based documents e.g. by reducing their resolution. 

Click on the ‘Open’ button 
to attach the selected file to 
your application. 
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Viewing attached documents 

You may encounter the following information message when trying to view non-PDF documents that 
you have attached: 

             

If so, you can change your settings – to allow such documents to be opened – via the following 
Adobe Reader menu path: 

 Edit > Preferences > Trust Manager 

Check the box Allow opening of non-PDF file attachments with external applications and then click 
OK to confirm the setting change: 

    

Revise list of participating organisations and update existing application form  

Should you at any time be required to follow the procedure described in Part B of this guide, you will 
be obliged to re-perform any attach operation you had already carried out. Please therefore ensure 
that you keep copies of all your attachment files. 
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STEP 6: VALIDATION AND SUBMISSION 

Validation of your eForm 

The Validate Form button appears at the bottom right of every page of the form.  

     

It is recommended that you do not validate your form until you have finished completing it as 
validation slightly alters the look of the form. 

When you are ready, click on the button and various checks will be automatically performed to 
ascertain whether your form is ready for submission. For example, the validation will verify that all 
mandatory fields have been completed, that all budget table rules have been respected and that all 
the mandatory attachments are present.  

If there are any errors present, the total number of them will be listed on the last page of your form. 
If there are any budget or attachment errors these will be itemised separately in the same list:  

 

The errors themselves will be highlighted in pink, as illustrated in the example screenshot that 
follows: 

 

Please note this screenshot is just an example – not all forms will include a summary of the project 
or a field C.7. 
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When you validate, an additional button – the Go to next error button – appears next to the Validate 
form button.  

 

Use this button to jump from error to error in your form. The function starts with the error nearest 
the top of the form i.e. nearest to Page 1 and, as you click the button, it descends the form moving 
to the next error with each click. 

Please note the following: 

 When you fix the errors that are highlighted, the Errors list is not dynamically updated. It is 
only updated i.e. refreshed when you perform another validation. 

 The Go to next error function works best when you fix errors one by one, following the top-
to-bottom sequence used by the Go to next error button. If you fix errors out of sequence 
e.g. fix an error further down the form, the Go to next error function will still follow the 
original sequence of errors reported by the validation.  

 If you have fixed errors out of sequence, you are recommended to perform a fresh 
validation so that the errors you have fixed are removed from the sequence (and you would 
then start again from the error nearest the top of the form). 

 If you prefer, you can simply do a visual search for the pink errors in your form. If you do 
this, it is recommended that you first turn off the highlighting for mandatory fields. You may 
also find the thumbnail view a useful aid to quickly detecting the pink highlighted fields. 

Whichever method you use, fix the errors that are present and validate your form again. If all errors 
have been resolved you will see the following pop-up message: 

 

Until your form validates successfully the Submit this form button is disabled and it will not be 
possible to submit your form. The Submit this form button turns from grey to green when validation 
has been carried out successfully. 
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Submission of your eForm 

On the final page of the form is the Submit this form button. Once your form has been successfully 
validated the button is enabled (as confirmed by its green colour). Before proceeding with the 
submission, please ensure you have successfully tested your submission capability using the Test 
your connection button. The button's operation, and what to do if the test fails, are described in the 
Technical requirements section of this user guide.  

Please note: the submission process includes the locking of the data and attachments in your form. 
You may therefore wish to take a backup copy of your form before you begin the submission 
process.  

When you are ready, click on the Submit this form button to begin the submission. 

 

The following message will appear: 

 

If for any reason you do not want to continue, you may click No and carry out the submission at a 
later time. The submission process will end. Once you click Yes your form will be locked and it will 
no longer be possible to modify its content or change the attachments. 

Should you encounter any error messages during the submission of your form, please refer in the 
first place to the ‘Known Issues’ section of the eForm home page: 

http://eacea.ec.europa.eu/eforms/index_en.php#issues 

The mandatory save BEFORE submission 

If you click Yes, the next step of the submission process is a mandatory save. The following message 
appears: 

 

When you click OK, the form triggers a Save As operation. You will see the classic Save As window as 
appears in the screenshot which follows.  

(Please note: this screenshot is simply an example of the Save As window. The window that you see, 
will reflect the filename and directory name that you have been using.)  

http://eacea.ec.europa.eu/eforms/index_en.php#issues
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You must now perform the Save As by clicking on the Save button. 

Very Important! 

You must NOT change the filename of your eForm. 
You must keep the same filename that the file had when you began the submission operation! 

Click Yes when you are asked if you want to replace the existing file: 

 

Submission 

Depending upon your security settings, the following pop-up window may now appear: 

             

If the window appears, click on the Allow button in order to proceed with the submission. 

Example screenshot 
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When the submission is complete you will see a pop-up message similar to the one that follows: 

 

Click ‘OK’. 

The mandatory save AFTER submission 

When you click OK, the form triggers another Save As operation. This is so that you cannot 
mistakenly close the form without saving (and so lose the submission number).  

Once again you will see the classic Save As window appear: 

       

You must now perform the Save As by clicking on the Save button. 

Very Important! 

You must NOT change the filename of your eForm. 
You must keep the same filename that the file had when you began the submission operation! 

  

Example screenshot 
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Click Yes when you are asked if you want to replace the existing file: 

 

When you click Yes, the submission number is automatically added to the Submission number box, as 
seen in the following example:  

 

It is also inserted into the footer of your form. 

The form has also been saved and this save included the submission number. 

Your submitted form is now ‘locked’. That is to say, it has been converted to a read-only document: 
changes cannot be made to it and it cannot be re-submitted. 

As part of the submission process, an email message acknowledging receipt of your eForm is 
automatically sent to the email address you entered for the contact person.  

Printing your eForm 

The eForm can be printed using Adobe Reader’s standard menu-driven print function. The Print 
button is found on the tool bar, or the Print menu can be selected from the File menu.  
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B. Revise list of 
participating organisations & 
update existing application 

eForm 
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Throughout this section of the guide, the function 'Revise list of participating organisations and 
update existing application eForm' is abbreviated to the phrase 'revise-and-update'. 

When to use the 'revise-and-update' function 

The following table explains when you need to use this function and when you don't. 
Please note that this revision can only be performed if your eForm has not already been submitted. 

Type of change 
Revise and 

update eForm? 
Action to take 

One or more 
participating 

organisations has 
withdrawn from the 

application * 

No 

Simply delete the organisation(s) from the 
eForm using the delete organisation button.  

Check that your organisation profile still meets 
any eligibility criteria that apply to your selected 
funding opportunity! 

One or more additional 
organisations 

 will participate in 
 the application 

Yes 
The organisation(s) must first be registered in 
the EACEA Participant Portal. Then use the 
revise-and-update function to incorporate them. 

The protected details of 
any participating 

organisation (including 
the Applicant 

Organisation) have 
changed 

Yes 

Update the details of the organisation(s) in the 
EACEA Participant Portal and then use the 
revise-and-update function to incorporate the 
changes. 

Change of the Applicant 
Organisation 

No 

It is not possible to change or delete the 
Applicant Organisation within the eForm. 

Abandon your existing eForm and create a new 
one. 

 
* If you ONLY have organisations to delete, this can be performed directly in the eForm using the 
delete organisation button. However, if you have organisations to delete combined with a 
requirement to add organisations and/or modify organisations whose protected details have 
changed, you should use the revise-and-update function to perform all the changes, including the 
organisation deletions. 

What happens to my existing eForm and its content? 

When you use the revise-and-update function, you upload your existing eForm and any content that 
you had entered – text, menu selections, checkbox selections etc – is automatically integrated into 
the updated version of the eForm that is created.  However, any document attachments you had 
attached to your eForm are NOT retained and are NOT integrated into the updated version of the 
form. Therefore, once you have completed the revise-and-update function and saved your updated 
form, you will need to re-perform the attach operations. 

Please note that content relating to organisations that you remove from your form will be 
automatically deleted and will not be integrated into the updated version of the form. 
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STEP 1: REGISTER ORGANISATIONS 

If you have any new participating organisations to add to your application, ensure that they have 
been registered and PICs allocated to them in the EAC/EACEA Participant Portal. 

Likewise, if there are any existing participating organisations for which the protected details have 
changed, visit the Participant Portal to register the changes. 

Enter the Participant Portal 

Once you have carried out this first step, navigate to the Application eForm Homepage 

Application eForm homepage 

As with the creation of your application eForm, the place to go to revise and update your form is the 
Application eForm homepage: 

Application eForm homepage 

Once again, pay careful attention to the important points that are listed on the page. 

Once you have considered and, where necessary, addressed these points, you can proceed with the 
revision of your eForm by clicking on the following button: 

 

  

http://ec.europa.eu/education/participants/portal/desktop/en/home.html
https://eacea.ec.europa.eu/PPMT/
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STEP 2: UPLOAD EXISTING APPLICATION EFORM 

The first page you come to requires you to upload your existing application eForm: 

 

 

 

Confirm correct eForm has been uploaded 

The key details of your uploaded eForm are presented on-screen: 

 

If the correct eForm has been uploaded, click on the Next step button to continue. Alternatively, click 
on the Previous step button to upload a different eForm. 

(ii) Click on Open to 
select the file 

(i) Click on Browse to 
locate your eForm 

pdf file 

(iii) Click on Upload  
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STEP 3: REVISE LIST OF PARTICIPATING ORGANISATIONS 

The page that appears allows you to add new organisations and remove existing ones. The functions 
work in the same way as described earlier in this guide, with the important exception that it is not 
possible to remove or change the Applicant Organisation (which is the first-listed organisation). 

 

Changes to the details of existing participating organisations 

If you have one or more organisations for which the organisation details have been changed in the 
EAC/EACEA Participant Portal (e.g. fields that are protected in the eForm), there is no action for you 
to take on this page. Those changes will be automatically included in the updated version of the 
eForm that you will shortly create. 

 
 

Once you have finished making your additions / removals, click on the Next step button. 
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STEP 4: CREATE AND SAVE REVISED APPLICATION EFORM 

Your revised organisation details are displayed: 

 

If there have been changes to the protected organisation details for any organisation, it is not 
possible through this page to see and verify those changes. Only additions and removals can be seen 
on this page. 

If the details are correct, click on the button Create revised application eForm. Alternatively, if you 
still have changes to make, click on the Previous step button. 

When you click on the Create revised application form button, a popup message appears: 

 

When you are ready, click OK to continue or Cancel to return to the details confirmation page. 

Save the revised application form 

When faced with the option to open or save the updated form, SAVE it to your local computer or 
network drive. It is recommended that you use the Save As option, so that you can precisely select 
the location where the file is saved.  

If you do not save your revised and updated eForm, you risk losing it and having to start the revise 
and update activity again.  
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STEP 5: COMPLETE REVISED APPLICATION EFORM 

Please refer to Step 5 in section A of this guide. 

STEP 6: VALIDATION AND SUBMISSION 

Please refer to Step 6 in section A of this guide. 
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Technical assistance 

If you encounter technical issues that are not addressed in this guide you may contact the EACEA 
Helpdesk to request assistance. The contact details and hours of operation are as follows: 

EACEA Helpdesk Availability 

Tel: +32 229 90705 

Email: eacea-helpdesk@ec.europa.eu 

08:30 to 17:30, 
Monday to Thursday 

08:30 to 17:00, 
Fridays 

Excluding public holidays 
and European Commission holidays 

All times are Brussels time 

 
When contacting the Helpdesk, please have the following information to hand or include it in your 
email message: 

 Your telephone number and your email address; 

 The programme and funding opportunity you are applying under; 

 The following details for the computer that you are using to complete and submit your 
application: 

o The version of Adobe Reader (or Adobe Acrobat) that is installed; 
o The internet browser and version you are using; 
o The operating system and version installed on the computer; 

 Details of any error messages / error codes that you encountered; 

 Screenshots of the problem (if contacting the Helpdesk by email). 

This is an example of an error code: 

 

  

mailto:eacea-helpdesk@ec.europa.eu
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Non-technical assistance 

The EACEA Heldpesk staff are only authorised and trained to help applicants who are encountering 
technical problems.  

If you have questions relating to non-technical issues e.g. if you have a question about the eligibility 
rules governing the organisation profile, please contact the programme team responsible for the 
funding opportunity you are applying under. The mailbox address for the programme team will 
generally be published on the EACEA website on the funding opportunities webpage of the 
programme concerned.  

The following table provides some further examples of technical and non-technical questions. 

Technical Questions 
(handled by the EACEA Helpdesk) 

Non-technical Questions 
(handled by the programme team) 

I can’t save the eForm I created. 
What is required to be entered for the field 
Status? 

A dropdown list isn’t working. Why isn’t country A in the dropdown list? 

I can’t attach my budget form (or other 
annexe/attachment). 

I need help with completing my budget form. 

I can’t delete a table row that I have entered. Why is this field mandatory? 

My form freezes/crashes. 
Our project has more than one coordinator. 

What should I do? 

My form is working slowly. 
What documents are required for the application 
package and where do I send it? 

My form won’t validate. I need more characters for my answer! 

My form won’t submit. 
Where are the templates for the attachments and 
additional documents? 

I think there is a bug in the form. 
What should I enter in the form for my project 
start and end dates? 
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Annex 1 - Specific advice & instructions for your application eForm 

Application eForm: Erasmus+, KA1 Joint Master Degrees, 2014. 

Character limits 

This table provides the character limits for all text fields where the limit has not been cited directly 
on the eForm itself. The limit includes spaces between words. Numeric fields are not included in the 
table. 

Part Field Character Limit 

First Page Project title 300 

Project acronym 7 

A 

Street name and number 57 

Postcode 12 

Town 60 

Cedex 60 

PO Box 60 

Telephone 1/Telephone 2/Fax 60 

Title 25 

Family name 62 

First name 62 

Department/Faculty 40 

Role in the organisation 32 

Email address 100 

B.1 Summary of the project 3000 

B.2 Describe briefly how your project addresses these priorities 500 

 

 


